# Table of Contents

Overview ................................................................................................................................................... 5  
Menu and Toolbar..................................................................................................................................... 6  
  File Menu ........................................................................................................................................... 6  
  View Menu ........................................................................................................................................... 8  
  Chart Menu ......................................................................................................................................... 9  
  Tools Menu ....................................................................................................................................... 10  
  Options Menu .................................................................................................................................... 10  
  Toolbar .............................................................................................................................................. 10  
Left Pane Area ......................................................................................................................................... 11  
  Chart and Pen Settings ....................................................................................................................... 11  
  General Chart Settings ...................................................................................................................... 12  
Chart Pens ............................................................................................................................................... 13  
  Normal Pens ..................................................................................................................................... 13  
  Pen Backups .................................................................................................................................... 15  
  Pen Backup Settings .......................................................................................................................... 15  
Special Pens and the SD Expression Editor .......................................................................................... 17  
  Expression Editor for Tag Pen .......................................................................................................... 17  
  Expression Editor for Special Pen ...................................................................................................... 18  
The Chart Area ........................................................................................................................................ 19  
  The Cursor and Legend ..................................................................................................................... 20  
Plot Area Menu ...................................................................................................................................... 22  
Chart Control Area .................................................................................................................................. 22  
  Window Width ................................................................................................................................... 22  
  Time Span Editor ............................................................................................................................... 23  
  Start and End DateTime values ........................................................................................................ 23  
  Window Width Mode .......................................................................................................................... 23  
  Time slider ....................................................................................................................................... 24  
  Scroll Data buttons ............................................................................................................................ 24  
  RealTime button ............................................................................................................................... 24  
  Chart Scale Selection- ....................................................................................................................... 24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Load Tracking System</td>
<td>43</td>
</tr>
<tr>
<td>New Batch Loads</td>
<td>43</td>
</tr>
<tr>
<td>Current Batch Loads</td>
<td>46</td>
</tr>
<tr>
<td>Batch Load History</td>
<td>47</td>
</tr>
<tr>
<td>Searching Loads</td>
<td>49</td>
</tr>
<tr>
<td>Revision History</td>
<td>50</td>
</tr>
</tbody>
</table>
Overview

Purpose: The SuperDATA Recorder II Program is a video chart recorder that is capable of displaying historical and real time process data, notes and alarms. The Recorder is multi mode capable and can connect to both Data Center (SDC Mode) and SDIO log data (SDIO Mode), and also to offline archived data.

Recorder Screen Layout
The Recorder screen consists of five areas:

1. Menu and Toolbar
2. Left Pane Area
3. Chart Area
4. Chart Control Area
5. Status bar
Menu and Toolbar

File Menu

Open Chart – Opens a dialog to select an existing chart definition file from the default trend chart directory. This menu item is the same as clicking on the “Open File” icon on the toolbar.

If SDRecorder is operating in SDIO mode opening a legacy trend chart file (*.ctm) will automatically convert the file to a chart definition file (*.sdx). The original .ctm file will be retained.

If SDRecorder is operating in Data Center mode all the charts will have a *.sdc extension.

New Chart – Opens a new chart definition file. This menu item is the same as clicking on the “New Chart” icon on the toolbar.

Copy Chart – Opens a Copy Chart dialog box that allows you to “Clone” the chart and pen settings to an identical furnace with a different name and Primary Group, (Channel), number.

Connect Server - Establishes a connection to the server computer data source, either SDIO or Data Center.

Disconnect Server - Breaks the connection to the server computer data source.
**Save Chart** – Saves the chart definition file. On the toolbar, there are “Save” and “Save As” icons. Using the Save menu or the Save icon will save the chart with the “Name” supplied in the Chart Settings. Using the “Save As” icon will give you a chance to change the name. Changing the name will also change the chart's “Name” in the Chart Settings.

**Recent Chart Files** - Allows you to open a chart from a list of the “most recently used” chart files.

**Print Settings** - Opens the “SDRecorderII Print Settings” dialog. Allows you to select what will be printed with the chart as well as common printer settings. This menu item provides the same functionality as clicking on the “Print Setup” icon on the toolbar.

**Print Preview** – Opens a preview window for the report. This menu item is the same as clicking on the “Print Preview” icon on the toolbar.

**Print** – Prints the report. This menu item provides the same functionality as clicking on the “Print” icon on the toolbar. **Note:** Printing can be done from the Print Preview dialog and the Print Preview dialog can be opened from the Print Settings dialog.
**View Menu**

The View Menu controls what areas of the screen are displayed.

Left Panel – The left panel is a multipurpose tabbed panel that may be used to display the Chart Settings, Data List, Note List, Alarm List, or Recipe. The left panel may be closed by clicking the X in the upper right corner of the panel. The left panel may also be opened by using the “Left Panel” icon on the toolbar.

**ToolBar** - Displays (checked) or hides the toolbar area.

**Status Bar** – Displays (checked) or hides the status bar area.

**Chart Control** – displays (checked) or hides the Chart Control area.
Chart Menu
The Chart Menu is used to control the operating modes of the trend chart.

RealTime Mode – Sets the RealTime mode – the chart updates in one minute intervals. The chart area background color will be light green.

Historical Mode – Sets the chart in Historical mode. The chart area background color will be light blue.

Window Width Mode – There are 3 methods to specify the window width. The specified method will control which inputs are active in the Chart Control area.

- Start Time + Window Width – Start and Window Width inputs are active, End is not active. This is the default mode.
- End Time + Window Width – End and Window Width are active, Start is not active.
- Start Time and End Time – Start and End are active, Window Width is not active. This is the mode most commonly used for “Load Reports” where the Load-In and Load-Out times are known.

Apply Default Window Width – this applies the default Window Width from the Chart Settings.
**Tools Menu**

- **Search** - Opens the Search Dialog for Searching Notes for specified text. The Search icon on the toolbar also opens the search dialog. (discussed in the Search Tool topic, Page 29).

- **Export Data** - Opens the Export Data Dialog for exporting the Data Center's data to an archive that can be used to view charts offline.

- **Export CSV/TSV file** - Opens a dialog to export current chart data to a CSV or TSV file for use in a spreadsheet or other application.

- **Manage Users** - Opens the Manage Users dialog. (Discussed in the Users topic, Page 32).

**Options Menu**

The options menu allows you to select or edit program modes for SDRecorderII.

- **Select Mode** - Allows you to select from a list of existing named operating modes.

- **View/Edit Mode Settings** - Allows you to view, create or edit named mode settings. See Page 34 for details.

**Toolbar**

Most of the toolbar icons have been discussed above. One has not: the Refresh icon.

- The Refresh icon refreshes the chart display.
Left Pane Area

Chart and Pen Settings

Chart settings define a “Chart”. The Settings tab in the left pane contains a “Tag Selector” Tree. The Tag Selector will be bordered in red when the server is not connected. Below the Tree is a “Refresh Tree” button that can be used to get a fresh copy of the tree.

Below the Tag Selector is a “Property Settings” window. The “Property Settings” window is used to view and edit the general chart settings and the chart's pen settings. At the top of the Property Setting box are 3 controls:

- **Settings Selector** - Provides a dropdown list of chart items. The first item is always the chart’s general settings. Following items are Pens contained in the chart.
- **Special button** - used to add pens that are “derived” from one or more tags.
- **Remove button** - button used to remove the selected pen.
**General Chart Settings**

**Alarm Method** - Selects what alarms should be displayed on the chart. Settings are:

- **All** - Displays all alarms.
- **Group** - Displays alarms only for the chart's Default Group.
- **None** - No alarms are displayed.

**Paper Color** - Sets the color of the chart paper.

**Name** - Sets the name of this chart. This name is also used as the filename with an extension of .sdx (SDIO Mode) or .sdc, (SDC Mode).

**Title** - Sets the title text that appears at the top of the chart.

**Default Window Width** - Sets the default window. Expressed as a “timespan” variable \( d \cdot hh:mm:ss \) where \( d \) is days, \( hh \) is hours, \( mm \) is minutes and \( ss \) is seconds. This value can range from 5 minutes to 10 days. (NOTE: Days and hours are separated by a decimal point, whereas the other values are separated by colons.)

**Grid Color** - Sets the color of the grid lines in the plot area.

**Default Group** - This is the group used for the Alarm, Note Group modes and Recipe Viewer tab. When the first Pen is added, the Default Group is set to that Pen's parent group; the group may be changed if desired.

**Note Method** - This setting selects what notes should be displayed on the chart. The Settings are:

- **All** - displays all notes.
- **Chart** - displays all notes associated with this chart.
- **Group** - displays all notes associated with this chart’s Default Group.
- **None** - no notes are displayed.
**Chart Pens**

Pens plot the trend lines on the chart. There are 2 types of pens:

**Normal Pens**

Normal Pens are pens that plot a tag's value (for example, Temperature, Temperature Setpoint, etc.). Normal pens are added to a chart using the “Tag Selector” tree. Right clicking a tag in the tree will display a menu with “Add Pen”, the Tag's ID (TID), and a snapshot of the tag's current value. Clicking “Add Pen” will add the pen to the chart and set the properties window below for the new pen.

**Special Pens**

Special Pens are pens that are derived from more than one tag value (for example, Average Temperature). Special Pens are added to a chart using the “Special” button. This button opens the “SD Expression Editor” described on Page 17.

**Pen Settings**

- **Pen Color** – Color of the pen on the chart.
- **Pen Width** – Width of the pen line on the chart.
- **Pen Active** – True or False – when false, the pen and the pen's scales will not be displayed on the chart, legend, lists or printed reports.
- **Pen Backup** – These settings discussed below.
- **Name** – Name displayed for this pen in the Chart Legend.
- **TID** – The Tag ID for a Normal pen. For a Special pen, this will be an index based on the number of Special Pens in the chart.
- **TagExpression** – Expression used to define a function of the Tag or for “Special” pens a function of more than one Tag.
- **Scale Title** – Title to print with scale – leave blank for no title (this will save space).
- **Scale Location** – There are 3 options:
  1. None – scale not displayed
  2. Left – displayed on the left
  3. Right – displayed on the right
- **Min Scale** – Minimum Scale value for this pen.
- **Max Scale** – Maximum Scale value for this pen.
- **Min Scale** – Minimum Scale value for this pen.
- **Scale Format** – format string for this scale – also used to format the pen values displayed in the Chart Legend.
- **Scale Type** – Normally Linear. Exponent and Log are also available for exponent or log data.
Pen Settings

**Pen Color** - Color of the pen on the chart.

**Pen Width** - Width of the pen line on the chart.

**Pen Active** - True or False - when false, the pen and the pen's scales will not be displayed on the chart, legend, lists or printed reports.

**Pen Backup** - These settings discussed below.

**Name** - Name displayed for this pen in the Chart Legend.

**TID** - The TagID for a Normal pen (with SDIO, the TagID is (channel * 10000 + slot). For a Special pen, this will be an index based on the number of Special Pens in the chart.

**TagExpression** - Expression used to define a function of the Tag or for “Special” pens a function of more than one Tag.

**Scale Title** - Title to print with scale - leave blank for no title (this will save space).

**Scale Location** - There are 3 options:
- None - scale not displayed
- Left - displayed on the left
- Right - displayed on the right

**Min Scale** - Minimum Scale value for this pen.

**Max Scale** - Maximum Scale value for this pen.

**Scale Format** - Format string for this scale - also used to format the pen values displayed in the ChartLegend.

**Scale Type** - Normally linear. Exponent and Log are also available for exponent or log data.

Note. For selected SuperSystems 9000 series instruments, Tag Expression, Min Scale, Max Scale and Scale Format will default to normally expected values.
**Pen Backups**

Pen backup settings are special settings used to fill in “critical” missing data when there is a compatible alternate data source. Compatible data sources could be backup servers running SDIO independently. SDRecorder will use the primary source and fill missing data with data from the backup source.

**Pen Backup Settings**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BuEnable</td>
<td>False</td>
</tr>
<tr>
<td>BuDirectory</td>
<td></td>
</tr>
<tr>
<td>BuTID</td>
<td>0</td>
</tr>
<tr>
<td>BuTagExpression</td>
<td>none</td>
</tr>
</tbody>
</table>

**BuEnable** - Enables the use of the backup data source. This is normally false and must be set to true to use the backup data. This would normally only be done when there is essential missing data. The Bu Directory, Bu TID and Bu Tag Expression must be set in order to set BuEnable to true.

**BuDirectory** - This is the “Alternate Data” directory containing the backup data source. This directory could be a local directory or a network share. The directory must contain the intparms.xxx files, the comdata, log and clog subdirectories. The comdata subdirectory must contain the inttbl.dat file and the log and clog directories must contain the hourly and compressed data files as desired.

**BuTID** - This defines the Backup TID. If the primary TID is based on a Channel/Slot then this BuTID will be selected from a Tag Selector dialog based on the Alternate data source. If the primary TID is a derived TID, then this BuTID will be the same as the primary TID (but using a different tag expression).

**BuTagExpression** - If the BuTID is derived, the Expression Editor will be used to generate the expression. The Expression Editor will use tags from the alternate data source.
Notes on Backup Data

1. Backup directories may be different for each pen.
2. Backup Data will cause some slowdown in retrieving data.
Special Pens and the SD Expression Editor

In most cases, Tag values will be plotted directly; however, there will be instances where you will want to chart values that are derived from one or more tag values.

- When a Pen is a function of a single Tag, simply add the Tag and click on the “TagExpression” property - this will open the Expression editor with the Tag as a single variable.
- When a Pen is derived from more than one Tag, it is called a Special Pen. Special pens are created by clicking on the Special button. Clicking on the “TagExpression” property for “Special” Pens opens the Expression Editor with a “Variable Selector”.

The Expression editor is a tool used to create expressions from constants, mathematical functions and logical functions using SDIO Tags as variables. The expressions can be tested and evaluated with the editor. When the chart is redrawn, data is retrieved for all tags used as variables in special pens and the value for each special pen point is calculated for plotting.

Expression Editor for Tag Pen

(No Tag Selector available)
Expression Editor for Special Pen

**Variable Selector** – A Tree view of the Tag data from which tags can be selected and added to the “selected variables” list. This tree will be a list of the configured connections, groups and tags.

**Selected Variables** – A list of variables that may be used in the special pen’s expression. When using the editor to edit a previously created special pen, this list will be initialized with the tags used in the expression. The value displayed in this list is a “snapshot” and will change only when the tag is added to the variable list or when the “Check syntax and evaluate” button is clicked and the variable is part of the expression. A Right click on a row will insert the variable into the expression (you may also double click on the row).

**Check Syntax and Evaluate button** – Clicking this button will check the syntax and evaluate the expression. The result will be found in the “Result” box.

**Save Expression button** – Saves the expression to the pen’s expression.

**Expression view box** – Displays the expression. You may also edit the expression in this box.

**Result box** – Displays the result when clicking “Check Syntax and Evaluate”.

**Operators and Constants** – Usual math operators.

**Logical Operators** – Logical operators always result in 0 if false and 1 if true.

**Math Functions** – Usual math and trig functions.

**Logical Functions**

- **IIF** - IIF(x,y,z) is an “if-then-else” construct. If x is true then return y else return z. IIF functions can be nested to a depth of 8.

- **Bit** - Bit(x,y) returns 1 if bit y of value x is ON. Otherwise, it returns 0.

**Special Functions** – SRound is a special rounding function used with load thermocouple values.

**NOTE:** In the US, the point is used as the decimal separator; in many other locales, the comma is used as the decimal separator. When the point is used as a decimal separator, the comma is used as a variable separator. When the comma is used as a decimal separator, the semicolon is used as a variable separator.

**Example:** In the US, IIF(t10001>0, 12.5, 9.2) is a valid expression, while in France the expression would be IIF(t10001>0; 12.5; 9,2)
The Chart Area

The Chart Area is the main display. The interior, called the “plot area” or “chart paper” contains the pens, note points, alarm points, spec limit lines and a cursor. Surrounding the plot area is the chart “border area”. The border area contains the “title” at the top of the chart, a DateTime box (upper right), a pen “legend” below the DateTime box, Y axis “pen scales” on the right and/or left of the plot area and an X axis time scale on the bottom of the chart.

The chart area may be in either “RealTime” or “Historical” mode. In RealTime mode, the border area background is light green.

In Historical mode, the border area is light blue.

When the recorder is in an “online” mode and the server becomes disconnected, the border area will be light yellow.
The Cursor and Legend - In RealTime mode (green border), the cursor is not visible and the legend always displays the current values (right chart edge) of the pens. Right-clicking anywhere in the plot area activates the cursor and places it at the x-axis (time) clicked. The cursor is displayed with a menu and the values in the legend are the values of the pens at the x-axis (time) position of the cursor. The chart will automatically go into historical mode. When dragged with the mouse, the cursor will move, and the legend values will follow.

Legend Menu - Right-clicking on a pen in the legend will display the legend menu for that pen.

Hide/Show Pen - The menu will display “Hide” (pen name) if the pen is currently visible or “Show” (pen name) if the pen is currently hidden. Clicking this item will either hide or show the pen in the plot area. This can also be done by left-clicking on the pen name. The text for hidden pens will be in dimmed italics.

Hide/Show Scale - Clicking this item will hide or show the scale for this pen in the border area.
Statistics - Clicking this item will display the “Pen Statistics” dialog for this pen. This dialog will display the number of points for this pen in the plot area. For those points, the minimum, maximum, average and standard deviation are calculated and displayed.

Spec Limits - spec limits are normally specified by some engineering criteria. Lower Spec Limits (LSL) and Upper Spec Limits (USL) may be entered here and may be displayed on the chart by checking the checkbox. The “Calculate” button will calculate limits that will result in CP and CPk of 1.0.

CP and CPk - When Spec Limits are entered, clicking “Calculate” will display values of CP and CPk based on Spec Limits and the data in the current plot area.

Notes in the Plot Area - Notes are displayed as points in the Plot Area. Note points are black circles. When hovering the mouse pointer on or near the point, the note information will be displayed.

Zooming in the Plot Area - You may zoom in on an area in the plot area by holding the left mouse button down while dragging the mouse. The zoomed in area will be outlined. The plot area will be zoomed in on as soon as the mouse button is released. If the Chart is in RealTime mode it will change to Historical mode as soon as the chart is zoomed. Zooming limits are enforced at about 0.1% of vertical scale and horizontally at about 5 point intervals.
**Plot Area Menu** - When the right mouse button is clicked in the plot area it repositions the vertical cursor (associated with the legend) and displays the Plot Area Menu.

- **Add Note** - Opens the “Add Note” dialog. This menu item will be disabled if the chart's “Note Mode” setting is set to none.
- **Un-Zoom** - Un-zooms the last zoom operation.
- **Undo All Zoom** - Un-zooms all zoom operations.
- **View/ Edit Note** - If the mouse is on or near a note point, this menu item will appear.

**Note:** Adding or editing a note requires User Login with a user level of 3 or greater when using Secure note mode.

---

**Chart Control Area**

The Chart Control Area is just below the Chart Area and is used to control the Start, End and Span time of the chart.

**Window Width** - The width of the displayed plot area expressed in days, hours, minutes, and seconds. When a chart opens, the chart's Default Window Width is always used. After the chart is opened, the width may be changed in several ways:

1. By zooming in on the plot area;
2. By editing the width using the time span edit editor;
3. By selecting a specific width using the drop down list; or
4. By changing both the start and end times.
**Time Span Editor** - The spin buttons increase or decrease the time span based on the spin mode. Spin mode can be set by right-clicking the spin button.

**Drop down list** - The dropdown list is activated by clicking on the button. You may then select a specific time span value.

**Start and End DateTime values** - Start and End values may be changed using the dropdown calendar or editing the DateTime value directly.

**Window Width Mode** - There are 3 methods for specifying the window width. The specified mode will control which inputs are active in the Chart Control area. The mode can be changed in the “Chart Menu”.

- **Start Time + Window Width** - Start and Window Width inputs are active, End is not active. This is the default mode.

- **End Time + Window Width** - End and Window Width are active, Start is not active.

- **Start Time and End Time**. Start and End are active, Window Width is not active.

**Apply Changes button** - There is a button to the right of the “Time Span Editor” that is used to apply changes any time a change is made to Start, End, or Width values. When changes are pending, the button will be green and enabled. Clicking this button will cause the chart to refresh with the new values.
**Time slider** - Any time data is retrieved, an extra amount of data is called, generally 4 times the amount specified by the window width. This allows you to look additional data without retrieving more data. The slider indicates how much data there is and what data you are looking at. The width of the slider indicates the data that has been retrieved. The width of the slider bar within the control indicates the data that is being presented in the plot area. You can drag the slider bar to pan through the currently retrieved data. You can click on the small arrows at either end of the slider control to make minor shifts (approximately 1/8th of the data), or you can click on the area between the bar and the endpoint arrows to make major shifts (approximately ¼ of the data).

**Scroll Data buttons** - The left (back) and right (forward) data buttons must be used when the desired data is not within the current data set. These buttons “scroll” the data forward or backward by one window width per click.

**RealTime button** – The RealTime button places the chart in RealTime mode. This button will not be active if the chart is in an “alternate” mode or if the server is not connected.

**Chart Scale Selection** - When there are hidden chart scales, directly clicking on any chart scale will cycle through the undisplayed scales. This enables you to maximize the chart area and still display another scale when desired.
Left Pane List Views

The Left Pane is a tabbed control. The Settings tab has been discussed previously; the other tabs will be discussed here.

The Data and Notes tabs are List views that display information that is synchronized with the Chart View. The left pane can be resized by dragging the panel splitter control.

Data Tab - The Data List view displays all of the points in the current plot area. The data is synchronized via the cursor. Moving the cursor in the Chart will cause the row values corresponding to the cursor to be selected in the list view. Selecting a row of data in the list view will move the cursor to that time in the chart view.

Notes Tab - The Notes List view displays all of the notes in the current plot area. Selecting a note in the list view will move the cursor to that time in the chart view; however, moving the cursor does not affect the list view.
Alarm Tab - The Alarm List view displays all of the alarms that occurred in the current plot time span. It is only available in Data Center mode. This tab is activated automatically once the first Alarm is defined for the chart. Selecting an alarm in the list view will move the chart cursor to that time in the chart view; however, moving the cursor does not affect the list view.

Recipe Tab – This tab contains an interactive recipe application that enables the operator (with the proper security permissions) to start, stop, and modify any 9xxx recipe associated with this chart.

All interactivity starts with a user login. Click the Login button and the Login screen appears.

Enter your user name and password and click OK. Your user name will be displayed where the login button was. The tab is now active.
**Run Mode**

Right clicking anywhere on the recipe listing will display a dropdown list of the following functions when clicked:

- **Hold Recipe** – Causes the recipe to pause at the current segment elapsed time.
- **Continue Recipe** – Allows the recipe to continue.
- **Advance Recipe** – Skips to the next step of the recipe.
- **Adjust Soak Time** – Adjusts the soak time in the recipe.
- **Stop Recipe** – Immediately stops the recipe.
- **Run Recipe** – Opens a dialog box for entry of the recipe number and step number if required. When you click **OK** the recipe starts immediately.
- **Clear Alarm** – Acknowledges any pending alarm and advances the recipe to the next step.

**Preview Mode**

Right clicking anywhere on the recipe listing will display a dropdown list of the following functions when clicked:

- **Preview Recipe** – Opens a dialog box for entry of the recipe number.
- **Clear Alarm** – Acknowledges any pending alarm and advances the recipe to the next step.
**Edit Mode**

The Edit mode enables editing of any recipe residing in the instrument associated with the current chart as defined as the Default Group in Chart settings. See Page 12.

The editing is limited to setpoint and time values. Step additions, deletions, and function modifications need to be done using the Instrument Configurator application.

Right clicking anywhere on the recipe listing will display a dropdown list of the following functions when clicked:

- **Run Edited Recipe Once** - Immediately starts the edited recipe once. The edits are not saved.
- **Edit Recipe** - Opens a dialog box for entry of the number of the recipe to be edited. When you click **OK**, the recipe to be edited appears in the window.
- **Cancel Edits** - Deletes any pending edits and returns the recipe to its original state.
- **Save Recipe** - Saves the modified recipe to the current recipe number.
- **Save Recipe As** - Opens a dialog box for entry of the recipe number to which the edited recipe is to be saved. When you click **OK**, the edited recipe is saved to that recipe location in the instrument.
- **Clear Alarm** - Acknowledges any pending alarm and advances the recipe to the next step.
The Search Tool

The Search Tool is used to search for text in notes or alarms. Enter the text to search for and the date range to be searched, and then click the “Search Notes” or “Search Alarms” button. The search results will be displayed in the “Search Results” list. You may then select a row in the “Search Results” and “sync” that item to the chart. When you “sync” the item, the chart will refresh with new data and put the cursor at the item. If the Alarms or Notes List view is opened, it will also be refreshed.

If the Search All Alarms or the Search All Notes checkbox is selected, the search will cover all charts in the database within the selected date range matching the search text.

If the note selected is located on a different chart than that displayed, a dialog box will be displayed asking if you want to switch to that chart. If you click yes, the background chart will update to the one where that note is located.
Printing a Chart Report

Selecting the Print Settings from the File menu or clicking on the “Print Setup” icon in the toolbar will open the “Print Settings” dialog.

Printer Settings – Opens a dialog that allows you to select a printer and specific printer settings.

Page Settings – Opens a dialog that allows you to select page settings including orientation and margins. For instance, Landscape will display the chart on the first page and the notes on the second; Portrait will display both the chart and notes on the first page.

Click Preview to view the results of setting changes.

Report Title and Content – Check boxes that allow you to specify what data is to be printed in the report. One or more should be checked. Enter a Report title if needed.

Preview – Closes this dialog and opens the preview dialog.

The Print Preview allows you to view one or more of the pages before printing. You may print from the printer icon or exit and print using the menu. In the following sample a Chart with a Note and a Notes table are all printed in the report and the report is in portrait orientation.
Exporting Data

The export data tool is used to save configuration and data to an alternate directory structure for offline use.

You specify the root directory for the archive data (there is a browse button available for this) and check the items you want to include in the archive. You also specify the date range for the data you want to include in the archive. Click the OK button to save the data (a progress meter will appear while the data is being copied). That data can then be used offline using an “alternate” mode in the Recorder. (NOTE: Archived data is not automatically removed from the current data files). There are three principal reasons for making archive data sets.

1. To archive older data and remove it from the local computer to increase disk space and performance. (NOTE: Removing the data is a manual operation.)
2. To make a data set that can be used offline at another location (for example, SSi may request a data set to aid in troubleshooting a problem you may be having).
3. To save data and start a new data set following a major control instrumentation replacement or upgrade.

Exporting to a CSV/TSV file

This export tool exports the data in the current “Plot Area” of the chart to a csv or tsv file for use in a text file or more commonly a spreadsheet (for example, Excel).

- **CSV** - Select this for a “comma separated value” file.
- **TSV** - Select this for a “tab separated value” file.

**Data Point Interval** - Set the point interval for exporting the data. The minimum point interval is one minute. The maximum point interval is one hour.

**Save to File button** - opens the Save As dialog.
**Users**

User accounts are required for adding and editing notes in SECURE Operating Mode and for interaction with the Recipe viewer tab. Simple Operating Mode Notes may be added and edited without a user account.

A user database is maintained with user names, passwords and user levels. User passwords must be at least 3 characters long. Passwords may be longer and may contain numbers. User levels can range from 0 through 99. In this application, the notes require a level of 3 or greater. User account administration requires a user level of 10 or greater.

**User Login** - When you attempt to open “Manage Users” from the Tools menu, add a secure note, edit a secure note, or interact with the recipe viewer tab, you will be greeted with the User Login dialog. Names are not case sensitive, while passwords are case sensitive.

**Manage Users** - When you select “Manage Users” under the tools menu and successfully login, you will be presented with the “Manage Users” dialog. In the Manage Users dialog, you may add or delete users, assign user levels and reset passwords.

User levels are set as follows:

Levels 0 through 2 - View only.
Levels 3 through 9 - View and Modify.
Levels 10 and over – View, Modify and Manage users.

When a new user is added, the password will be set to the user name and must be changed on that user’s first login. The “Reset Password” button also sets the password to the user name and requires that user to change his or her password on next login. The “Show Password” button will reveal the password for the selected user as long as the mouse key is held down on the button; the password replaces the button text.
Starting SDRecorderII with Command Line Arguments

SDRecorderII may be started with Command Line Arguments from a command line or from another application. The following arguments are supported:

- M: (name of configuration to use)
- C: (name of chart to use)
- ST: (start date and time)
- ET: (end date and time)

All arguments are optional and may be used in any order. The following rules apply:

- If any spaces are used, the argument must be enclosed in quotes.
- If the configuration (M:) is not used, the current configuration will be used.
- If the chart (C:) is not supplied, the last chart used will be loaded.
- If the ST: and ET: are not supplied, chart starts in RealTime.
- If ST: is supplied and ET: is not supplied, chart starts at ST with Default Window Width.
- If ET: is supplied and ST: is not supplied, chart starts at ET – Default Window Width.
- If ST: and ET: are supplied, chart starts with ST and Window Width = (ET-ST).

Examples:

- SDRecorderII C:myChart “ST:7/12/2010 10:15”
- SDRecorderII C:myChart “ET:7/12/2010 13:30”
SDRecorderII Operating Modes

Before loading or creating a chart, the Recorder must know where the data comes from and what type of data is being used. This information is contained in the “Operating Mode” file. There can be several operating modes; each can be saved in a named file, which is an XML file with an extension of .cfg and will normally be located in the \SS\Bin folder. These configuration files may be viewed, created and edited with the “SDRecorderII Settings” dialog.

NOTE: When the application is started from a remote computer (for example, started from a mapped drive) the “Operating Mode” files may not be appropriate for the local computer; in this case, a special restricted Operating Mode is used. These modes are discussed on Page 37.

**Stored Configurations** - This drop-down will display a list of configurations on the local machine. Select one for viewing in the property windows below. When opening the dialog from the Options menu, the current configuration in use will be pre-selected.

**Identity** - This is the configuration name and is used to name the file. The file will name be this name with a .cfg extension. If you change this name and subsequently save the configuration, a new file with this name will be created.

**Note Mode** - There are two modes: Simple and Secure. In the Simple mode, notes may be added and deleted and there is no required login to Add/Edit or Delete notes. In Secure mode, Adding and Editing notes requires a login and deleting notes is not permitted. This setting requires a Login to be changed.

**Operating Mode** - The information required in the lower property box is dependent on the “Operating Mode” selected. This mode should **always** be set before proceeding to the lower box.

**SDRecData**

**Online** connects to a “Server” to get real time and historical data.

**Alternate** gets data from an archive location – data is offline and there is no server.

**Note:** Chart display, control and operations are the same for all Operating Modes with one exception: “RealTime” operation is not available in “Alternate” modes (historical data only).

**SDRecMode** - either Data Center or SDIO
Operating Mode Details

Mode: SDIO – Online

**Server** - Specify Localhost or Server IP Address or DNS Name.
**Chart FilePath** - Specify the directory that will contain the Chart Files; this may be on the local machine or on a remote computer.
**Clog Path** - Specify the directory containing the compressed log files.
**ComPath** - Specify the directory containing SDIO's communication files (for example, inttbl.dat, msgtbl.dat, etc.).
**ConfigPath** - Specify the config directory for SDIO.

**LogPath** - Specify the directory containing the SDIO hourly log files.
**NoteDB** - Specify the path and filename for the Notes Database.

Mode: SDIO – Alternate

**DefaultDir** - Specify Directory for the Archived data.
**Clog Path** - Specify the directory containing the compressed log files.
**ComPath** - Specify the directory containing SDIO's communication files (for example, inttbl.dat, msgtbl.dat, etc.).
**ConfigPath** - Specify the config directory for SDIO.
**LogPath** - Specify the directory containing the SDIO hourly log files.
**NoteDB** - specify the path and filename for the Notes Database.
**Mode: Data Center – Online**

**Server** - Specify Localhost or Server IP Address or DNS Name for remote connections.

**Chart FilePath** - Specify the directory that will contain the Chart Files - this may be on the local machine or on a remote computer.

**SqlInstance** - Specify the path to the database instance. Normally `localhost\SQLEXPRESS`.

**UseAccessNotesSDB** - Specify either True or False. In most cases this will be set to false when using DataCenter mode.

**Mode: Data Center – Alternate**

**DefaultDir** - Specify Directory for the Archived data.

**ChartFile Path** - Specify the directory containing the archived chart files.

**SDHFilePath** - Specify the directory containing archived compressed data files.

**ConfigTree** - Specify the path to the archived configtree.cfg file.

**SqlInstance** - Specify the path to the database source. Normally, this is `localhost\SQLEXPRESS`.

**SSiDataDB** - Specify the path and filename for Data Center hourly Tag Database.
Restricted Operating Modes
Normally, SDRecorderII will be started from the local computer and will have operating mode files specific to that computer. SDRecorderII can be installed from a network drive or mapped drive. The operating mode files on the remote location may not be appropriate for use on the local computer.

These restricted modes are primarily intended for use with legacy SuperDATA applications. In the SuperDATA RealTime/RealEdit HMI, applications normally reside only on the server and, when used at a workstation, are started from a drive mapped to the server. Any time SDRecorderII is started from a network drive or a mapped drive, it will use a restricted operating mode.

There are only two restricted Operating Modes: RealTimeSDIO and RealTimeDC. These operating mode files will always reside in the application directory on the server.

When used on a workstation, RealTimeSDIO is modified based on the workstation's SDIO.ini file.

When used on a workstation, RealTimeDC is modified based on the Server Name.

When operating in a restricted mode, the Options menu will be hidden, and you will not be able to change Operating modes.

Limiting Operating Modes - Examples

SDRecorderII may be set to limit operation to SDIO mode or DC mode. When installed as SDRecII for SDIO, SDRecII will default to use only SDIO Operating modes. When installed as DataCenter or DataCenter Client, SDRecII will default to using both SDIO and DC modes. These limitations can be changed at any time by running SDRecII from the command line with the MA: option as follows:

- To limit SDRecII to SDIO run: **SDRecorderII MA:SDIO**
- To limit SDRecII to DC run: **SDRecorderII MA:DC**
- To remove limits run: **SDRecorderII MA:BOTH**
Using Automatic Update Feature

Updates for SDRecorder II are posted regularly on the Super Systems file server and are available at no charge to all registered users.

**Note:** You must have internet access to use Automatic Update.

To access the updates, click on the Help menu item and select **Check for Updates**.

If there are no Updates newer than the version on your computer, the notice will appear as shown on the left. Click **OK** to return to SDRecorder II.

When an update is available you are offered the option to install the update now or at a later time. To install now, click **Yes**.

If upgrading from:

- **SDRecorderII in SuperSystems\bin directory** (SDCClient upgrade): Shut down any data center apps running from that directory (locally or on remote computers). NOTE: It will not be necessary to shut down SDCMaster or SDConfig as they will not be upgraded.
- **SDRecorderII in SSi Bin directory** (SDRecII for SDIO upgrade): Shut down any other instances of SDRecorderII from that directory (locally or on remote computers). NOTE: It will not be necessary to shut down SDCMaster or SDConfig or any other DataCenter apps.

During the update process, a progress screen is displayed.

Upon completion of the update, SDRecorder II will return to its original state with the updates installed. Restart any instances of SDRecorder II running on mapped workstations.
Appendix

Batch System Option
The Batch option adds a system to keep track of batch loads in an SQL database, link those loads to historical load charts, and provide load reports.

Installation of the Option
SDRecorder II ships with the Batch Option code installed. It simply needs to be activated.

Activation of the Batch Option
To activate the Batch Load Tracking option, click on the Help menu item and select About.

You will be presented with the SDRecorder II About window.

Click on the Activate button.

A Login box will appear. Enter your User Name and Password and click OK.

If you want to activate the batch tracking system for a 30 day trial period, contact Super Systems sales department for a temporary license code.

If you purchased SDRecorder II with the batch tracking option, refer to the software package for the license code.

Enter the license code you received from Super Systems and click OK.

The Batch menu item and Batch Icons will appear at the top of your SDRecorderII window.
**Configuration of the Database**

The first time you use the database you will want to configure the record headers, (Titles), as you wish them to appear in the data display screens and reports.

From the Batch menu select Batch Administrator and then Configure Database.

A Login box will appear. Enter your User Name and Password and click OK.

You will be presented with the Configure Batch System window.

Tabs along the top separate the five tables of the database.

- The Name column contains the internal, default title of the record.
- The Caption column contains the custom title of the record. This is the only field you can edit.
- The Type and Length columns are fixed and are shown only for informational purposes.

To add a custom title to a column, double click the Caption field.

The Edit Caption box will open. Enter the new caption and then click OK. The new caption will appear in the table.

Repeat this process for all the column titles you want to customize in all the tables.

When finished, close the configuration window by clicking on the Red "X" in the upper right corner of the window.
**Adding System Data**
The next step is to populate the database with Furnace, Part and Customer data.

**Furnace Data**
From the Batch menu, select Batch Administrator and then Add/Edit Furnaces.

A Login box will appear. Enter your User Name and Password and click OK.
You will be presented with Add/Edit Furnace Table window.

For each furnace, enter the name, channel, and instrument type, and check the Active checkbox to establish communications.

**Part Data**
From the Batch menu, select Batch Administrator and then Add/Edit Parts.

A Login box will appear. Enter your User Name and Password and click OK.
You will be presented with the Add/Edit Part Table window.

For each Part, enter the name, Recipe, Part Weight, and Weight Units, and check the Active checkbox to indicate Part is used presently.
Customer Data
From the Batch menu, select Batch Administrator and then Add/Edit Customers.

A Login box will appear. Enter your User Name and Password and click OK.

You will be presented with the Add/Edit Customers Table window.

For each Customer, enter the name and check the Active checkbox to indicate the Customer is currently valid.
Using the Load Tracking System

New Batch Loads
From the Batch menu select New Batch Loads.

A Login box will appear. Enter your User Name and Password and click OK.
You are presented with the New Batch Loads window.

Dropdown Furnace pick list to select to display either all pending new loads or only those destined for a particular furnace.

Tabs used to select the display of New, Current, Historical, Searched or Inactive load data. Tabs with restricted access will be grayed out if the user priority is lower than what is required.

Start the load entry process by clicking the **New Load** tab.
The New Batch Loads screen will open.

From the Furnace dropdown list, select which furnace the load is to be processed.
Select the Customer and Part from the dropdown lists provided. Enter the Batch ID number, Quantity of parts, and Shop Order number. The Add button should be activated, indicating that all the required information is complete. Review your entries for accuracy and, if correct, click on the **Add** button to register these parts in the Batch Load.

Additional parts can be added to the Batch Load by repeating the above process. There is no limit to the number of different parts in a load. If the recipe for the added part is different than the first part added to the load, then an alert box will open, requesting a supervisor’s approval for the part’s inclusion.

When you are finished entering parts to the load, click the **Save and Start Load** button if you are going to immediately charge the load into the furnace.

If it will be some time before you charge the load into the furnace, then click the **Save Load** button. The Batch will be added to the New Load queue for later processing.

When you do load the Batch into a furnace immediately select that load record and click the **Start Load** button to inform the program when the load started processing. That load will now be part of the Current Loads listing and a note will be added to the chart record.

You may queue up as many loads as you wish. In fact, you can use this as a simple production scheduler.
**Supervisors Only**

If for some reason a queued load needs to be modified, you can right-click on the load record and a popup menu will appear. Click on Make Load Inactive. This will change the load records status to inactive.

All inactive loads are accessible to supervisors only by clicking the **Inactive Loads** tab.

Supervisors may modify any inactive load record within limits. For instance, a change to the number of parts in the load requires that the total part weight field be updated to reflect the effect of the new part count.

When all adjustments to the load record are completed, click on the **Save** button. The edited load record will be returned to its original location.
Current Batch Loads

When you click on the Current Batch Loads tab you are immediately presented with the Current Loads Screen. Everyone can access this screen.

If you are logged in as a Supervisor or Operator (permission level 3 or higher), an additional button **Mark Load Completed** is revealed. When the furnace cycle is complete and the load is out of the furnace, click the **Mark Load Completed** button. The load record TimeOut field will be completed, and the load record will be transferred to the Load History records.

The Sync to Chart button opens the chart for the selected furnace and adjusts the chart start time to correspond to the time in value.
Batch Load History

When you click on the Load History radio button, you are immediately presented with the Current Loads Screen. Everyone can access this screen.

The screen opens, displaying all loads from all furnaces completed in the last seven days.

When the Load Report button is clicked the Print Settings dialog box opens.

Select the date range desired using the date picker boxes.
The Load Report button is used to generate a load report for the selected load.

Sets which printer to use, its configuration and options.
Sets the page layout configuration and options.
Use this selector to edit which customer’s parts appear on the report.

Click on the Preview button to view the report on the screen.

Edit the report title and select the report content by checking the boxes.

The following is a sample of the print preview window. You may print a hard copy directly from the preview. **Hint:** If you do not have access to a color printer, you may print to a PDF file printer and email the report to interested parties.
Searching Loads

The Batch Loads screen contains a tab for “Search Loads”. This view displays all loads that satisfy the current search criteria. If no search criteria have been set, the view will be empty. Search criteria are set with the Search Criteria dialog – opened by right clicking on any load screen and selecting the “Search Loads” menu item from the context menu or by clicking on the Search Icon in the upper right corner of the window.

The Search Criteria dialog allows you to build complex search conditions. Each condition has a drop-down selector. The selector contains some special key words and database values.

Keywords

Any - any value is acceptable.

Like - any value that satisfies the “like” specification is acceptable.

Range - any value within the specified date range is acceptable.

A drop-down may also contain a specific value—for example, a Furnace, a Part or a Customer. When a specific value is specified, only records satisfying that condition will be returned.

Like conditions - When a like condition is selected, a text box is supplied to specify the condition. Conditions are specified using characters and wildcards. The “*” wildcard specifies a string of any characters and a “?” specifies any single character. (conditions are not case-sensitive)

Examples:

- *e* - any customer that has an e in the name.
- * inc - any customer that ends in inc.
- e???shop - any customer that has e characters followed by shop (for example, TheShop, OneShop, metshop, etc).

Compound Conditions - When multiple conditions are set, they are combined.

Search conditions persist. Any time you open the Search Criteria dialog, the previous search will be set and you can add, remove or modify those conditions. When the Batch Loads screen is closed, the search conditions are cleared.
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Description</th>
<th>Date</th>
<th>MCO #</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>First Release</td>
<td>02/26/2012</td>
<td>2097</td>
</tr>
<tr>
<td>A</td>
<td>Chart Scale Selection added&lt;br&gt;New Decimal note added&lt;br&gt;Text and layout changes included</td>
<td>09/12/2012</td>
<td>N/A</td>
</tr>
<tr>
<td>B</td>
<td>Content for SDIO and SDC versions of software combined into one manual&lt;br&gt;Additional functionality updates</td>
<td>06/10/2013</td>
<td>2126</td>
</tr>
</tbody>
</table>